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1. Introduction

1.1  HMS Overview
Holdings Management and SOFA (HMS) is an integrated technology platform designed to support the physical management of permanent, hard-copy archival records in the custody of NARA. HMS combines in a single system the archival functionality currently distributed across multiple systems (both manual and automated) throughout the agency. A key aspect of HMS is the introduction of container level control and tracking. 

HMS has replaced several existing applications and tools used for archival processes (Figure 1).
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Figure 1: Legacy System Map
1.2 New HMS Terminology 

While the terminology and references have been modified for certain HMS terms, their functionality still remains same and intact.
What is a Record Entry?

A Record Entry in HMS is equivalent to a Location Register Entry. 

What is an Asset?

In HMS an Asset is primarily refers to a container but, can also be used to designate a folder or item. 

What does the Availability Status mean?

The Availability Status shows whether the record entry or asset can be expected to be on the shelf. If a record entry or an asset is Unavailable, then this status will provide the reason.

2. Getting Started

2.1 Logging into HMS

To log in to HMS, perform the following steps: 

1. Open Internet Explorer (web browser).

2. Enter the following web address for the HMS training environment: http://gpeatest.archives.gov/hms81.  To access the live system use http://eservices.archives.gov/hms/start.swe. 
3. A login screen (as shown on Figure 2) appears.
4. Enter assigned User ID and Password. 
5. Click the arrow button. 
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Figure 2: HMS Login Screen
After a successful log in to HMS, the system displays the home page with a Welcome message. The page may show additional applets (frames) depending on the user’s business unit and role. 

2.2 Changing or Resetting HMS Account Password 
To change/reset an account password in HMS, perform the following steps: 

1. Click the View menu tab at the top of the HMS screen.
2. Select the “User Preferences” option (see Figure 3).
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Figure 3: “User Preferences” option in the View drop-down
3. Enter a new password in the Password field (see Figure 4).

4. Re-enter a new password in the Verify Password field.

5. Click the Save button. 
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Figure 4: User Profile page
2.3 Web Browser Navigation Functions: Back, Forward, History, & Refresh 
To navigate back and forward in the HMS application, click the web browser's Back or Forward buttons (see Figure 5).
[image: image6.png]6 3 Holdings Management and SOFA - TESTL - Windows Internet Explorer

B © ~ [ ree/spestestarchives gov/hmss sart swerSWECmd=LogeifasweTs=16417 + | ¢ ] X | [ 8ing

File _Edit
i Favortes | i3 ) Web Siice Gallery

Favorites _Tools _Help

[ 3 Holdings Management and SOFA - TESTSL 1 v B v = @ v Pagev Safetyv Toolsv @~

ORACLE’

Holdings Management and
SOFA - TEST81 Innovation
Pack 2013





Figure 5: Web Browser Navigation Functions
To find recently accessed screens and views in HMS application, use the web browser's history (recent pages) function (see Figure 6).
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Figure 6: Recent pages drop-down
To refresh data in HMS application, it is recommended to use Siebel query functionality. First click the Query button (see Figure 7), then click the Go button (see Figure 8). 
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Figure 7: HMS Query functionality
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Figure 8: Go button of the HMS Query functionality
2.4 Exiting HMS
To exit (log out) the HMS application it is recommended not to close the browser window by clicking the Close button at the top right corner of the screen (see Figure 9). 
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Figure 9: Close function of the web browser window
Steps to follow to exit the HMS application:
1. Click the File tab from the application-level menu (see Figure 10).
2. Navigate to the “Log Out” option. 
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Figure 10: Exiting HMS application

3. Close the web browser window (see Figure 11).
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Figure 11: Closing the web browser window
3. HMS User Interface
The main elements of the HMS application window are shown on figure 12.
HMS application consists of Web pages. Each page displays HMS data surrounded by tabs, toolbars and top-level menu.

3.1 HMS Application Toolbar Controls
HMS Application-level menu is located in the upper left corner of the HMS application window (see Figure 12). Each menu option lets the user to perform a task.
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Figure 12: HMS Application-level menu
HMS Siebel application toolbar or Global Toolbar appears below the Application-Level Menu (see [image: image14.png]RecordEntry =
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Figure 13
). The left part of the toolbar provides quick access to frequently used tools, such as the Site Map and common tasks, such as accessing Reports. The Site Map allows the user to access a list of all application areas available to the user. The binocular icon on the left part of the toolbar allows the user to enter the search parameters and find the information in HMS. 
[image: image15.png]RecordEntry =
Home | Record Groups | Record Entries | Assets | Needs Assessment | Work Requests | Space Management

Record Entries
Presidential Record Entries for My Archival Unit [~ IR RAIIIIL ) Query | Create WorkRequest || Create Needs Assessment
Record Entry I Record Group/Co NAID. Record Entry Name Record Group De StartDate  End Date
HSL173517661 0000 Letters Congressional and &

HSL173512611 0000 TEST3 Congressional and &

HS1-170121041 0001 123456789 PREMTESTL War Labor Policies B




Figure 13: HMS Global Toolbar
Tools available in the Global Application Toolbar are described in Table 1.

Table 1: Application Toolbar Controls
	Control
	Name
	Description
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	Site Map button
	Displays the site map.
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	Search button
	Activates the Search functionality, which allows the user to search and find records within HMS.
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	Reports button
	Generates the reports for the screen the user is currently working on.
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	New query button
	Launches a new query.
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	Execute query button
	Executes a query after the user has defined query criteria.

	
	
	


3.2 HMS (Siebel) Application Window Components
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Figure 14: HMS Application Window Components

4. Navigating the User Interface
4.1 Screen Tabs
HMS application is divided into Screens tabs. A screen is a grouping of views that represents related data for a functional business area, such as Record Groups, Record Entries, etc. 
The user can access a screen by clicking the related screen tab or by using the Site Map functionality. An active Screen tab appears in a different color (see Figure 15). 
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Figure 15: Active Screen tab
4.2 Visibility Filter

HMS Visibility filter allows the user to access a different set of records through the filter located under the Link bar (see Figure 16). It filters records based on the user’s role within HMS. 
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Figure 16: HMS application Visibility Filter
4.3 Link Bars

HMS Link bar provides the links to other HMS Screen-related data. The user access views by clicking a hyperlink in the Link bar. For example, if the user clicks the Record Entries screen, the link bar displays Record Entries link. The Link bar is located below the screen tabs. An active link appears in bold text (see 
Figure 17). 
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Figure 17: Active Link

4.4 View Tabs
HMS application Views exist within each screen. View tabs are located in the middle of the HMS application window. A view consists of one or more applets displaying the records. It may contain lists, forms and sub-views. A list consists of multiple records, presented as rows. Each record consists of multiple fields, presented as columns. A form shows the details for an individual record. An active View tab appears in a different color (see Figure 18).
[image: image25.png]i

CX Saved Queries: =

RecordEntry #:

Edit

Home | Record Groups | Record Entries | Assets | Needs Assessment | Work Requests | Space Management
Record Entries

Presidential Record Entries for My Archival Unit [~ IR RAIIIIL ) Query | Create WorkRequest || Create Needs Assessment 2-Bof 3+ | =

Record Entry I Record Group/Co NAID. Record Entry Name Record Group De StartDate  End Date Context Information SubDiv

FORFDRX 2

FOF FOR-FDRPOL 578390 Correspondence Relating to Dutchess Frankin D. Rooseve: Dec-20 Roosevelt, FrankinD. (FrankinDe =
FOR-259 FORMOPKN 579183 Presidents Speeches and Speech Mal Harry L. Hopkins Pay 1957 1995 Hopkins, Harry L. (Harry Loy,
FORMOPKN 579144 Engagement Lsts Harry L. Hopkns Pa; 1933 1990 Hopkins, Harry L. (Harry Loy,
FoR272 FORJAVESR 7773869 Reading Fies James Roosevelta 1955 1965 Roosevelt, James, _
FOR273 FORJAVESR 7722623 Secretary tothe PresidentFles  James RooseveltPa 1937 193 Roosevelt, James,
FOR-457 Correspondence 193 1995 Cox, Oscar
FOR-465 personal Carrespondence oy, (Abert) Wayne 3
‘ »
Assets | Legacy Numbers | Microfims/Digtals | Neads Assessment | Work Requests | Import Folders | Attachments | Notes | Audt —wu
FDR-228 1 210f28+ »
Mewv | [New |Edt| Query
Record Group/Collection # *:NAID: Record Group Description: General Record Type *: Archival Uit *:
FORFORR. FrankinD. Rooseve, X, Papers Textual Records R
Record Entry I0 *: Record Entry #: Total # of Containers: Availabilty
FoR 228 2 L Avalable [
Record Entry Name *: Beginning Location: Cubic Feet: Status *:
‘Congressional Correspondence Fies = nsnE actve [
Start Date: End Date: Ending Location: Need Levet: Status Date *:
184 1055 2} 08/13/15 )
Roosevelt, Frankin . (Frarkin Delano), = Unvestricted [ ﬂ
Sub Division: Specific Access: -
=
‘Sub Group: Classification Status *:

= Undassified (]





Figure 18: Active View Tab
4.5 Sub-view

A Sub-view displays additional detail about a record selected within a view. Sub-view tabs are located directly below the information displayed for a selected view tab. The sub-view provides more details about the record selected in the view. Not all views have e sub-views. If a view has a sub-view, the system displays it automatically. An active Sub-view tab appears in a different color (Figure 19). 
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Figure 19: Active Sub-view tab
4.6 The Difference between a Screen Tab and View Tab with the Same Name

There are Screen tabs and View tabs which have the same name (e.g., Assets) in HMS application. A Screen tab allows the user to access all records related to certain subject. For example, the Assets screen lists all Assets that belong to a single unit (see Figure 20). 

Assets view which is a part of the Record Entries screen displays all Assets that have been created for the selected record entry (see Figure 21). 
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Figure 20: Screen tab: Assets
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Figure 21: View tab: Assets
4.7   Records
A record is a collection of data organized into fields. The user can select an individual record in a list by clicking any field in the record. This causes the selected record to be highlighted (in yellow) and adds an active record indicator to the left of the record (see Figure 22). If the selected field is editable, the user can enter or edit data in that field. 
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Figure 22: Active Record Indicator
4.8 List Applets
After identifying the desired screen and selecting the screen tab, the user decides which set of records to view in the selected screen. A default set of records appears in a list below the screen tab. List applet displays records in rows (see Figure 23). To navigate in a list, use the vertical and horizontal scroll bars within the list applet. 

Vertical scroll bars are used to navigate between records in a list. Vertical scroll bars appear to the right of lists that contain more rows than can fit on the screen. Using the vertical scroll bar the user can navigate to the next record, the next record set, the previous record, or the previous record set. Table 2 describes the vertical scroll bar buttons.
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Figure 23: List Applet, Horizontal and Vertical Scroll Bars
Table 2: Description of Vertical Scroll Bar buttons
	Control
	Description
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	Go to previous record set
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	Go to the previous record
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	Go to the next record
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	Go to next record set


Horizontal scroll bars appear at the bottom of lists that contain more columns (or fields) than can fit on the screen. Use the horizontal scroll bar to move through all the columns currently being displayed.
Every list has a Show more button or Show less button in the top right corner. Clicking the Show more or Show less button allows the user to see more or fewer records.
When a list is collapsed, the user can click the Show more button to expand it, as shown in Figure 24. When a list is expanded, the user can click the Show less button to collapse it, as shown in Figure 25.
                    [image: image35.png]i

© M

RecordEntry #:

Edit

Saved Queries:

Home | Record Groups | Record Entries | Assets | Needs Assessment | Work Requests | Space Management

Record Entries
Presidential Record Entries for My Archival Unit [~
Record Entry ID Record Group/Co NAID

FORSL2
FoRS17
FORS1S
FoRE22
FoR25
FORE37
FOR541

T |

Menuv | New Query

Record Entry Name

Rogers, Gustavus (smal Colctions)
Roosevelt, Frankin D.; Address relat
Roosevelt, Anna Sleanor and Frankin
Roosevelt, Anna Eleanor: ER Press C
Roosevelt, Amna Eleanor: Remiiscen
Roosevelt, Frarkin D.: Copy of leter
Roosevelt, Frankin .; Handwitten

Create Work Request || Create Needs Assessment
Record Group De StartDate  End Date

113

1934
1892

1385

1973
1385

6-130f27+ |





Figure 24: Show more button in List
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Figure 25: Show less button in List
4.9 Form Applets 
When the user selects a record in a list (screen), the system displays a form applet below the View tab that contains details for the selected record (see Figure 26). A form displays the fields of a single record. 
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Figure 26: Form Applet

The user can use the record navigation buttons (as shown in Figure 26) at the top right of each form to navigate between records in a list. The record navigation buttons help the user to navigate to the next record or the previous record.
The users can edit information directly in the form if they have proper permission.
4.10 Common Buttons in Lists and Forms
The buttons described in 
Table 3: Common Buttons in Lists and Forms
Table 3 appear at the top of lists and forms. 
Table 3: Common Buttons in Lists and Forms
	Control
	Description
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	The menu button provides access to a menu of actions that apply to the active form, list, or a selected record in a list. Using the options in the menu, the user can perform actions such as copy, edit, delete, and advanced sorting.

If the user right-clicks in a form or a list the same menu of actions (as provided by the menu button) gets displayed in that form or list.
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	Lets the user create a new record. In a list or form, clicking this button inserts a new, empty row at the top of the list so the user can create a new record or displays a form with empty fields that the user can fill in to create a new record.
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	Lets the user edit record in form or list applet.
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	Lets the user define and launch a query in a form or list.


4.11 Practice Exercise # 1
Practice Exercise # 1

1. How many Screen Tabs does the user have? Which is the default Screen Tab the user lands upon login?
2. Navigate to the Record Entries screen tab. How many Link Bars does the user see below the screen tab?
3. On the same screen (Record Entries), how many View Tabs does the user see below the list of record entries? 
4. Select the first row in the Record Entry list and navigate to the Assets view tab. Find out how many assets this record entry has. 

5. Navigate back to the Record Entries list. How many record entries are shown when the user clicks the Show more button?
6. Now, click the Show less button in the same Record Entries list. How many rows does this list show now?  
5. Records and Fields

5.1 Fields and Field Controls

Each record consists of multiple fields.  For example, a Record Entry record may contain the following fields:  Record Entry Id, Record Group / Collection number, or Record Entry Name. 
Fields can be editable or read-only. If a field has a gray background, the field is read-only and the user cannot change the content. If the field is editable the user can click into that field to enter or edit information. 
A text field allows the user to type text directly into the field (see Figure 27). The user can click in the field and begin typing.

Lists and forms contain field controls (see Table 4). The user can enter data into the application by typing directly into fields or by using field controls. Field controls allow the user to do such things as choose from a list of predefined values, enter values in a multi-value field, specify dates, and calculate values. A field control can appear within a form or as part of a record in a list. To use a field control to edit a record in a list, click the control to activate it. In a form, the user can see the field control if one is available. In a list, the field control appears when the user clicks in a field that includes one.

Table 4: HMS Field Controls
	Field Control
	Description

	Text field with pop-up 
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	Pop-up text field allows the user to enter long texts in a pop-up window.

	Check box        (
	Clicking the box next to a field allows the user to select or clear the check box. When the user clicks an empty box, a check mark appears in the box. If the user clicks a box that is selected, the check mark disappears.

	Drop-down list    [image: image43.png]



	A drop-down list allows the user to click a down arrow button to the right of a field to select from a list of available values.

	Selection fields    [image: image44.png]
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	Single and Multiple select buttons allow the user to select from a list of associated records and select multiple values from a list respectively (see Sec. 5.2).

	Calculator button     [image: image46.emf]
	Calculator button activates a calculator to assist the user with calculations.

	Calendar select button  [image: image47.emf]
	Clicking the calendar button activates a calendar control for entering a date in a date field. The user can also type a directly into a field.


Required fields in an application record have a red asterisk beside the field label (see Figure 27)Figure 27: Required Fields example. The user cannot save a record until the data is entered in the required fields. 
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Figure 27: Required Fields example
5.2 Working with a Single Selection Field
The Single selection field, also known as a pick applet, allows the user to associate the selected record with another related record within HMS. For example, when working with a record entry, the user may need to tie this to a record group or collection. The selection field allows the user to associate the record entry to the relevant record group. 

To use the Single selection dialog box ([image: image49.png]


), perform the following steps:
1. Click the single selection button ([image: image50.png]


) in the appropriate field. The system displays a single selection dialog box a new window (see Figure 28). 
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Figure 28: Single selection dialog box
2. In the dialog box, locate and select the record to associate it with the current record within HMS (see Figure 28). To find records in the list, perform the following steps:
· To navigate in a list, use the vertical and horizontal scroll bars within the list applet (see Sec. 4.8 and Figure 25).  
· The user can use the Find/Starting with capability (see Figure 28). To use the Find/Starting with capability, first select the column to search against in the Find drop-down list. Then, enter a few characters in the Starting with field and click the Go button. The records matching user’s criteria appear. The user can select a record from the result set. 

· Another option is to use the Query functionality (see Sec. 5.4, Figure 30). 

· Click the OK button (see Figure 28). If the OK and/or Cancel buttons are not visible within the Single selection dialog box, expand the box diagonally to see these buttons.
5.3 Working with a Multi-Selection Field

The Multiple selection field allows the user to associate the selected record with multiple values or records within HMS. For example, when working with a record entry, the user needs to track the specific access/accesses for that record entry. The Multiple selection field allows the user to associate one or more specific accesses to the record entry. 

To use the multiple selection dialog box ([image: image52.png]


), perform the following:
1. Click the multiple selection button ([image: image53.png]


) in the appropriate field. A Multiple selection dialog box appears (see Figure 29). 
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Figure 29: Multiple selection dialog box
2. In the dialog box in the Available list of records, select the record to associate it with the current record (see Figure 29). The user can select multiple values/records by holding down the CTRL key and clicking each record.
· Click the Add button and the value/record is moved from Available list to the Selected list (see Figure 29).
· Another option is to use the Query functionality (see Sec. 5.4, Figure 31). 
· Click the OK button (see Figure 29). If the OK and/or Cancel buttons are not visible within the multi-selection dialog box, expand the box diagonally to these buttons.
5.4  Querying for Records in a Selection Dialog Box
The user can query within a selection dialog box to search for specific information from one column or from several columns at one time.

To query in a selection dialog box, perform the following steps:
1. In the selection dialog box, click the Query button (see Figure 30 and Figure 31). A blank row or a blank form appears in the selection dialog box.
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Figure 30: Query button in the Single Selection dialog box
[image: image56.png]1-100110. Selected | NoRecords
Speciic Access Restriction

Presdentsl Records Act (5)(6)Personal Prvacy
Presdental Records Act (5)(S)Confidenta Commun-
Prescental Records Act (5)¢)Trade Secrets and Cc.
Prescental Records Act (5)3) Sttte
Presdental Records Act (5)2) Appanimens o e
presdental Records Act (5)(1) Natonal Securty Clat
Presdental Records Act (RA)

Prescental Recordngs and Uaterias Preservaton A
PRUPA-Trade Secrts and Cammercalor Francall





Figure 31: Query button in the Multiple Selection dialog box
2. Enter required query criteria (see Figure 32 and Figure 33). HMS application automatically assumes a wildcard (*) exists at the end of text entered in the query fields (for more details see Sec. 7.4). This means that if the user searches for ‘FO’, the HMS application looks for all words beginning with the letters ‘FO’.
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Figure 32: Entering querying criteria: ‘FO’ in the Single Selection dialog box
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Figure 33: Entering querying criteria: ‘FO’ in the Multiple Selection dialog box
3. Click the Go button (see Figure 32 and Figure 33). The records matching query criteria appear (see Figure 34 and Figure 35).
[image: image59.png]



Figure 34: Query Results in the Single Selection dialog box
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Figure 35: Query Results in the Multiple Selection dialog box

5.5 Practice Exercise # 2

Practice Exercise # 2

Navigate to the Record Entries screen to perform the following exercises: 
1. Identify the required fields in the form applet.

2. Does the user have permissions to edit any fields? If so, name three.

3. Identify and locate an ID field (Hint:  Record Entry ID). Why is this field read-only?

6. Common Tasks

6.1 Saving Data

After the user has finished editing or adding a record in a form or a list, the changes can be saved doing one of the following:

1. Click off the record fields area (example: moving to another record, clicking another tab, etc) to save the changes in the HMS. 
2. Click the Menu button, and then select the “Save Record” option (see Figure 36). 
3. From the application-level menu, click the File button and then the “Save Record” option (see Figure 37).

4. Use the keyboard shortcut CTRL+S (on the keyboard, hold the Control key and S key simultaneously). 
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Figure 36: “Save Record” option in the Menu drop-down (Form Applet)
[image: image62.png]hival Unit (IR Query | Create WorkReguest | Create Needs Assessment 21-280f 28+ | =
Record Entry Name. Record Group De Start Date  End Date Context Information Sub Division

[Ctts Shift W] ‘Congressional Correspondence Fies _Frankin D. Rooseve' 1949 1955 Roosevelt, Frankiin D. (Frarkin De: fi
[CtrlShift+X] Correspondence Relating to Dutchess Frankin D. Rooseve Dec-20 Jan28 ‘Roosevelt, Franklin D. (Franklin De -

FORTOPRIT Presidents Specches and Spech Mal Harry L. Hopkins oy 1937 1995 Hopkins, Harry L. (Hary Uoyd),

FORHOPKIN Engagement ists Harry L. HopkinsPay 1933 199 Hopkins, Harry L. (Hary Uoyd),

FoR-272 FORIAVESR Reading Fes James RooseveltPa 1955 1965 Roosevel James,

FoR273 FORIAVESR Secretory totheresdentFles  James RooseveltPa 1937 1% Roosevel James, 5

FOR457 Correspondence 153 1385 Cox, Oscar





Figure 37: “Save Record” option in the File drop-down (Application Level menu)
6.2 Undo Changes 

The user may need to cancel changes to a record before saving it. The user can undo the edits to a record only if the user has not saved it yet. To cancel edits in a form or a list the user can do one of the following: 
1. Click the Menu button, and then select the “Undo Record” option (see Figure 38). 
2. Use the keyboard shortcut CTRL+U (on the keyboard, hold the Control key and U key simultaneously).
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Figure 38: “Undo Record” option in the Menu drop-down (Form applet)
6.3 Editing Data

The user may need to edit a record. To edit a record, perform the following steps:
1. Click the Edit button, and then make changes to the selected record (see Figure 39). 
2. Save the record changes (for details see Sec. 6.1). 
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Figure 39: Edit button (Form Applet)
6.4 Using Record Hyperlinks

Hyperlinks or drill-downs provide one-click access to detailed or additional information for the identified record (see Figure 40). For example, when an ID field is displayed in a list, it is shown as a blue hyperlink. These hyperlinks allow the user to go directly to more detailed information about the record. 
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Figure 40: Record Hyperlinks example

6.5 Resizing Columns

The user may need to modify the width of a column to view data better. To resize columns, perform the following steps:
1. Place the cursor over the column header divider. A resize arrow appears (see Figure 41). 
2. Click and drag the column divider to the right to widen the column, or to the left to narrow the column. 
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Figure 41: Resizing Columns example
6.6 Organizing Columns in a List

A list consists of many columns of data (or fields), some of which may not be displayed on the screen. The user can add, remove, and rearrange the columns by using the Columns Displayed feature.
To organize columns in a list, perform the following steps:
1. In a list applet, click the Menu button, and then select the “Columns Displayed” option (see Figure 42). 
2. The Columns Displayed dialog box appears (see Figure 43). If a column is in the Available Columns list, then it is currently hidden (not displayed in the list). If a column is in the Selected Columns list, then it is currently displayed in the list. Find the required column(s).      

3. Select one or more columns in one of the lists (Available Columns or Selected Columns). Hold the CTRL key to select multiple columns (see Figure 44).  
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Figure 42: Menu drop-down – “Columns Displayed” option
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Figure 43: Columns Displayed dialog box
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Figure 44: Multiple columns selection in the Columns Displayed dialog box
4. Use navigation buttons between the Available Columns list and the Selected Columns list to show or hide the selected columns (see Figure 45). Table 5 describes the use of each button.
Table 5: Description of the navigation buttons between Available and Selected Columns
	Button
	Description
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	Moves the identified available column(s) to the bottom of the Selected Columns list. Displays selected columns.
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	Moves the identified available column(s) to the bottom of the Available Columns list. Hides identified selected columns. 
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	Moves all available columns to the Selected Columns list. Displays all columns.
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	Moves all available columns to the Available Columns list. Hides all columns. 


5. Select a column in the Selected Columns list and use the column-ordering buttons to the right of the Selected Columns list to change the order in which the columns appear in the list (see Figure 45). Table 6 describes the use of each button.
Table 6: Description of the column ordering buttons
	Button
	Description
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	Moves the selected column down one position in the Selected Columns list and to the right in the list applet being modified.
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	Moves the selected column up one position in the Selected Columns list and to the left in the list applet being modified.
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	Moves the selected column to the bottom of the Selected Columns list, making it the right-most column in the list applet being modified. 
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	Moves the selected column to the top of the Selected Columns list, making it the left-most column in the list applet being modified. 


6. Click the Save button (see Figure 45). 
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Figure 45: Buttons in the Columns Displayed dialog box
The Reset Defaults button in the Columns Displayed dialog box allows the user to reset all list columns and sizes to the original order. By clicking this button the user loses all customized display of list columns for selected list applet. 

7. The user can also drag and drop columns in a List applet to reorder them (see Figure 46).
To drag and drop columns, perform the following steps:

· Click and hold the column header. 

· Drag the column header to the desired position. A red line identifies the column’s new position. 

· Release the column header to fix the position. It saves the changes only for this current session. 
· To make the reorder permanent, click the Menu button, select the “Columns Displayed” option, then click the Save button. 
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Figure 46: Drag and drop columns functionality (List applet)
6.7 Sorting Records in a List

The user can sort the records in a list in ascending or descending order by using the values in one or more columns. The active sort order of a column is shown in the column header: a full triangle pointing up (see Figure 47), means the data is sorted in ascending order by the values in the column; a hollow triangle pointing down (see Figure 48), means the data is sorted in descending order by the values in the column. 
To sort by a single column in ascending order, perform the following steps:
1. Click the column header of the column to be sorted (see Figure 47).
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Figure 47: Sorting by a single column in ascending order
To sort by a single column in descending order:

1. Click the column header of the column to be sorted.

2. Click the column header of the column to be sorted again (see Figure 48).
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Figure 48: Sorting by a single column in descending order
To sort by up to three columns at once use the “Advanced Sort” option:

1. In the List Menu drop-down select the “Advanced Sort” option (see Figure 49).
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Figure 49: “Advanced sort” option in the List Menu
2. In the Advanced Sort dialog box make proper selections. For example: the user might want to sort the accounts by the Record Entry Name, then by the Record Group/Collection#, and then by the ARC ID (see Figure 50). 
3. Click the OK button.
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Figure 50: Advanced Sort dialog box

6.8 Practice Exercise #3

Practice Exercise # 3
1. Navigate to the Record Entries screen. Change the columns displayed and column sizes as required below:

a) Hide the Sub Group and Sub Division columns;
b) Make the Agency column visible;
c) Move Record Entry Name next to Record Entry ID; 

d) Move General Record Type to be the 1st column on list; 

e) Move Created Date to be the last column in the list.
2. Increase the size of the Record Entry Name column.

3. Undo all changes made in Items #1 and 2 above (Hint:  Reset Defaults).

4. Select the first Record Entry in the list. Start typing the text ‘Exercise to cancel changes’ in the Comments field, but do not save the record or step off the record. Cancel edits or changes to this field. (Hint:  Does the system allow the use of the Cancel button? If not, what other method can be used?)
5. Rearrange the columns displayed and the columns sizes to meet user’s preferences, for all of the user’s lists within HMS application (both: screen tabs lists and view tabs lists) and save changes for each list. Log out from HMS application.
6. Log in back to HMS, navigate to each screen tab and verify that the system saved the changes to the displayed columns and columns sizes. 

7. Using Queries 
7.1 Creating, Executing, and Saving Queries
The query feature allows the user to enter specific query criteria to find records. Operators are used within a string of text or numbers the user is using to locate specific records and to help define the criteria. The user can use one or more criteria (i.e., enter criteria in one or more fields) to conduct the query. If the user uses multiple criteria, the query results contain records that meet ALL criteria. 

To create, run and save queries in a form or a list, perform the following steps:

1. Click the Query button in the form or list (see Figure 51).
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Figure 51: Query button in the List and Form Applets
2. Enter query criteria in the appropriate fields in the blank form or list row. 

3. Click the Go button to execute the query (see Figure 52). 
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Figure 52: Go button in the List and Form Applets
4. To save the query criteria for subsequent use:

· Create and run the query (as described above).   

· From the application-level menu, click the Edit button.

· Select the “Query” option.

· Select the “Save As” option (see Figure 53).
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Figure 53: “Save As” option in the Edit/Query drop-down
· In the Save Query As dialog box (see Figure 54

 REF _Ref342919150 \h 
Figure 53), type a name in the Query Name field.
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Figure 54: Save Query As dialog box
· Click the OK button. The saved query now appears in the Queries drop-down list (see Figure 55).
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Figure 55: Example of the Saved Query
Other ways to create and run queries (see Table 7):

Table 7: Creating and running queries
	Creating query
	Entering query criteria
	Running query

	In a list or form:

- Click the Menu button, 
- Click the “New Query” option.
	Enter the query criteria in the appropriate fields.
	In the list or form:

- Click the Menu button, 
- Click the “Run Query” option.

	On the Toolbar:

- Click the “New Query” button.
	
	On the Toolbar:

- Click the “Execute Query” button.

	In a list or form:

- Right-click and select the “New Query” option.
	
	In a list or form:

- Right-click and select the “Run Query” option.

	From the application-level menu:

- Click the Edit button,
- Click the “Query” option,

- Select the “New” option.
	
	From the application-level menu:

- Click the Edit button,

- Choose the “Query” option,

- Click the “Run” option.

	Use the keyboard shortcut ALT + Q (on the keyboard, hold the Alternate key and Q key simultaneously). 
	
	Use the keyboard shortcut ALT + ENTER (on the keyboard, hold the Alternate key and Enter key simultaneously). 


7.2 Getting Record Count
To find how many records are in the query result set, perform the following steps:

1. Click the Menu button (on list or form applet). 
2. Select the “Record Count” option (see Figure 56).  
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Figure 56: “Record Count” option in the Menu drop-down
3. Get the number of records from the Record Count dialog box (see Figure 57).

4. To close the Record Count dialog box, click the OK button. 
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Figure 57: Record Count dialog box
Other ways to get record counts (see Table 8):

Table 8: Getting Record Counts
	“Record Counts” option
	Getting the Record Counts
	Closing Record Counts

dialog box

	In a list or form:

-  Right-click and select the “Record Count” option.
	The Record Count dialog box gets displayed with the number of records.
	In the Record Count dialog box:

- Click the OK button.

	Use the keyboard shortcut CTRL + SHIFT + 3 (on the keyboard, hold the Control key, then Shift key, and 3 key simultaneously). 
	
	In the Record Count dialog box:

- Click the OK button.


7.3 Modifying or Refining Queries
To modify or refine an existing query, perform the following steps:

1. Click the Menu button on list or form applet. 
2. Select the “Refine Query” option (see Figure 58). 
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Figure 58: “Refine Query” option in the Menu drop-down
3. A new query, populated with the criteria or conditions used in the previous query, gets created.

4.  Add more criteria or modify existing criteria.

5. Execute the query by clicking the Menu button on list or form applet.
6. Select the “Run Query” option (see Figure 59). 
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Figure 59: “Run Query” option from the Menu drop-down
Other ways to get record counts (see Table 9):

Table 9: Getting Record Counts
	“Record Counts” option
	Getting the Record Counts
	Closing Record Counts 

dialog box

	In a list or form:

-  right-click and select the “Record Count” option.

	The Record Count dialog box gets displayed with the number of records.
	In the Record Count dialog box:

- click the OK button.

	Use the keyboard shortcut CTRL + SHIFT + 3 (on the keyboard, hold the Control key, then Shift key, and 3 key simultaneously). 


	
	In the Record Count dialog box:

- click the OK button.


7.4 Query Operators

The user can use simple query operators to define the query criteria (see Table 10).
Table 10: Query Operators
	Query Operator
	Purpose
	Example

	*
	Wildcard. Operator placed anywhere in a string, returns records containing the string or containing the string plus any additional characters at the position at which the asterisk appears, including a space. 
	Car* finds Car, Carson, Carbon, etc.

	OR, or
	Operator placed between values, returns records for which at least one condition is true.
	Army or Navy returns all records that have either the word army or the word navy in the query field.


7.5 Practice Exercise # 4
Practice Exercise # 4
1. Query for all record entries with Record Entry Name that contains the term ‘Roosevelt’ and get the record count.

2. Refine the query from Item #1 above to find only entries with Record Entry Name starting with ‘Roosevelt’ and having Record Entry Id FDR-831 and get the record count.

3. Query for all record entries that have the term ‘Correspondence’ in the Record Entry Name. (Hint:  Use wild card - *).
8. Understanding Record Entries in HMS
8.1 Record Entry Details

A record entry in HMS is equivalent to Location Register Entry.  HMS will track the following details about a record entry:

	Field
	Location Register
	Comments

	Record Group/Collection #
	RGN/CI
	

	Record Entry ID
	ID (prefixed with 'FRD-')
	Unique ID of the record entry (system generated)

	Record Entry Name
	Title
	Description of the record entry

	Start Date
	Beginning Date
	

	End Date
	End Date
	

	Context Information
	
	

	Sub Division
	
	Additional creating organization information

	Sub Group
	
	

	NAID
	NAID
	

	Processed?
	
	Identifies if the record entry has been processed

	Record Group Description
	
	

	Record Entry #
	Series #
	

	Beginning Location
	Beginning Location
	

	Ending Location
	Ending Location
	

	Access Restriction
	Access Restrictions
	

	Specific Access
	Specific Access Restrictions
	

	Classification Status
	
	

	General Record Type
	General Record Type
	

	Total # of Containers
	# of Containers
	

	Cubic Feet
	
	System calculated field

	Need Level
	
	

	Comments
	Comments
	

	Archival Unit
	
	NARA unit with intellectual custody of the record entry

	Availability
	
	

	Status
	
	

	Status Date
	
	


NOTE:  If a field has a red asterisk (*) beside it, then you must enter a valid value in that field in order to save the record.  
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Record Entry Details View

Similar to the MLR, the location of a record entry is tracked in HMS.  However, the format is quite different.  There are seven components to a location code in HMS (see above):  

	Archival Center
	Facility
	Stack (7 characters)
	Row (3 digits)
	Level
	Compartment (3 digits)
	Shelf

	32
	01
	0000M02
	002
	1
	00B
	01


For textual records at FDR Presidential Library, the Archival Center will always be 32 and the Facility will be 01.  

New to HMS is the concept of Level.  The level designates the shelving scheme for the materials.  If the materials are to be stored conventionally (shelves 1-7), then the level will be 1.  If the materials are to be stored on the 8th or 00 shelf, then the level will be 2.

In addition to the details, HMS will also provide additional information about:

· Assets

· Legacy numbers (transactions)

· And other system transactions associated to the record entry (risk assessments, projects, work requests, etc.)

8.2 Assets for a Record Entry 
Unlike the MLR, the container list for an entry will be directly linked to it in HMS.  The containers for a record entry will tracked as assets and can be viewed as part of the Assets view of any Record Entry.  
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In HMS, the information about an asset (or container) will be inherited (or copied) from the associated record entry.  
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Assets View for a Record Entry in HMS

When you drill-down on the Asset ID, you can access further details about the container.  They include:

· Folders/Items

· Legacy numbers (transactions)

· Copies

· And other system transactions associated to the record entry (risk assessments, work requests, etc.)

Folders/Items – Unlike the MLR, folder title lists and item level lists will be directly linked to the container (and thereby to the record entry) in HMS.  The data tracked for folders and items is very similar to those of containers, except the Asset Type is folder/file unit or item (as appropriate).  This data can be extracted easily for HMS for the creation of finding aids.  This is the default view when you drill-down on an Asset ID from a record entry.  

Legacy Numbers – Covered below for record entries.  For an asset, these are inherited from the record entry.   

Copies – Building on existing MLR capabilities, HMS also provides the capability to track whether a surrogate of an asset exists (e.g., microfilm or digital copy).  For copies, the type and location are tracked.  You will be able to tell if a surrogate of an asset is linked to its record if the Copy Available flag is checked (see below).  To see copies associated to an asset, click on the Copies view tab (after drilling down on the Asset ID from a record entry).  
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8.3 Legacy Numbers for a Record Entry
Similar to the Transactions Tab in the MLR, HMS provides a way for you to record the various transactions that are associated to a record entry.  The types of legacy numbers that can be associated to a record entry include:

· NN Accession Job

· Disposition Authority

· Declassification Project

· FRC Transfer

· IRC Project Number

· State Department Lot

For any accession, the NN Accession Job, Disposition Authority (if provided), and FRC Transfer (if provided) will be automatically populated under this view.  

To add a Legacy Number to a record entry:

1. Click the Record Entries screen tab to begin the task.

2. Find (using navigation and/or query functionality) and select the record you are working on.

3. Click the Legacy Numbers view tab.
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4. Click the [image: image98.png]


 button.  A new record will appear in the list.  

5. Select the Type from the list of values.  

6. Enter the number in the Legacy # column.

7. CTRL+S to save the record.
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You can add an unlimited number of Legacy Numbers to a single record entry.  

9. Getting Results Out of HMS
In general, HMS provides three ways to get out information about record entries:

· Record Entry Detail Report

· Asset Barcode
· Export 

9.1 Printing Record Entry Detail Report

In order to print the details of a Record entry within HMS, follow the steps shown below:

1. Navigate to the Record Entries screen tab.

2. Find (using navigation and/or query functionality) and select the record you are working on.

3. Click the Reports icon ([image: image100.bmp]) and select the Record Entry Detail report option.

4. The record entry detail report in PDF format will pop-up as a new window.  Click the print icon to print a hard copy of the detail report, and then close the pop-up window.

9.2 Asset Barcode
To generate and print Asset Barcode Report:
1. Navigate to the Record Entries screen tab.

2. Find (using navigation and/or query functionality) and select the record you are working on.

3. Go to the Assets view tab.

4. Select desired assets (use CTRL+Click to select multiple assets simultaneously).
5. Select Print Label field
6. Click the Reports icon ([image: image101.png]


) and select the Asset Barcode report option.

7. The Asset Barcode in PDF format will pop-up as a new window.  Click the print icon to print a hard copy of the report, and then close the pop-up window.
9.3 Exporting Data from HMS

To export query results in HMS to MS Excel:

1. Run the query for the required information.  

2. Click the [image: image102.png]


 button and select Export.  The Export Dialog Box will display.  
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3. Click the [image: image104.png]


 button to open the MS Excel file.  

NOTE:  You may be prompted to download the file.  If so, download it and open it.  
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